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1  Learn the Basics

Exploring this User's Guide

The Isuzu Worldwide application helps you find parts for the vehicle you are working on and accumulate a Review List of parts that you can save and/or print for future reuse or reference. This user’s guide provides detailed procedures, examples, and quick-reference information.

1
Learn the Basics
Identifies basic on-screen features and explains how to use the pull-down menus, function keys, tool bar, and mouse.

2
Search for Parts
Explains how to search for parts using a series of indexes, a part number, or a part name; how to use illustrations; how to select parts for a Review List; how to display part history and supersession information; how to find assembly parts; and how to navigate more quickly by taking a shortcut.

3
Use Manual Filters, VIN Filters, and Option Codes
Explains how to filter part text manually and how to decode a vehicle identification number, display option code information, and filter parts by typing a VIN or a portion of a VIN.

4
Accumulate a List
Explains how to display, modify, and print a Review List and save it for future use. This chapter also explains how to display history and supersession information for parts on Review Lists.

5
Additional Features
Explains how to create notes and attach them to part numbers or specific locations in the application and how to reset user utilities..

A
Windows 95/98
Explains how update the information stored in your system when your new CD arrives each month; turn the system on and off; open and close the application; and print.

B
Windows NT
Explains how update the information stored in your system when your new CD arrives each month; turn the system on and off; open and close the application; and print.

C
Troubleshooting
Provides some basic guidelines for troubleshooting your system if you have problems running the application.

Identifying On-Screen Features
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1
Menu Bar
Displays the pull-down menu names.

2
Tool Bar
Provides print, paging, and zoom tools.

3
Text/Illustration Window
Displays menus, indexes, illustrations, and part text.

4
Navigation Window
Shows the catalog, figure, VIN, and other information as you make selections.

5
Function Key Display
Displays the names of the top-row function keys. Click directly on a displayed key to activate its function.


Using Pull-Down Menus

The menu bar displays the names of the pull-down menus.
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Click on a menu name to open the menu. Each pull-down menu lists commands that activate application functions. Click on a command to activate its function.
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When a menu command is dimmed, it is not currently available. You may need to make a selection at the current screen or move to a different screen to use the command.

A triangle after a command indicates a submenu will open when you select the command. An ellipsis (...) after a command indicates a dialog box will appear when you select the command.

An underlined letter in a command indicates that typing the letter will activate the command. For example, open the Goto menu (shown above) and type S to open the Section Index.

A function key (F4) or key combination (Ctrl+F3) shown after a command indicates a keyboard shortcut you can take to activate a function.

You can also use the arrow keys to select menu options. First press the ALT key to highlight "File" on the Menu Bar. Then open a menu by using the right and left arrow keys to highlight a menu name. Use the up and down arrows to highlight a command and press ENTER.

The File Menu
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Configuration
Opens the Configuration dialog box for creating a printer message and changing screen colors.

User Utility
Displays the User Utilities menu for setting the function key display, the VIN List display, and Review List Pricing.

Print
Opens the Print dialog box. Click on “OK” to print the contents of the current screen. When an illustration is displayed with text, only the illustration is printed. To print the text, select Image On/Off from the Image menu to hide the illustration before selecting Print. When a multipage Review List is displayed, all pages are printed. The list is printed as displayed.

Exit
Exits the Isuzu application.

The Goto Menu
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Catalog Index
Displays the Catalog Index.

Section Index
Displays the Section Index.

Figure Index
Displays the Figure Number/Illustration Index.

The Find Menu
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All
Redisplays all the parts text for a figure number which had previously been limited by find filters and/or callouts.

Search
Lets you search for a part by number or name.

Filter
Opens the Filter Menu so you can set filters for parts displays. The Filter command and the FILT key are not available when you have entered a VIN. Clear the VIN to make them available.

Filter Toggle
Enables or disables both manual and VIN filtering.

Clear All Filters
Clears all previously set filters.

The Information Menu

[image: image9.png]Location Note  Ctl+F12





Location Note
Displays the Location Notes menu, which lets you add your own notes to specific screens; view, change, or list those notes; and list or print all part and location notes.

VIN Decoding
Displays an “Enter Vehicle Identification Number or Option Code” prompt so you can type a complete VIN, the last eight characters of a VIN, or a three-character option code. If “VIN Decoding Display” is turned on in the User Utilities, you can also select a VIN from a list of previously used VINs.

The Part Info Menu
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Part Note
Displays the User Added Part Notes menu, which lets you add notes to part numbers; delete or change notes; and list or print all user-added part and location notes.

History
Opens a Part History window, which lets you view history for a part in text or on a Review List.

Supersession
Opens a Supersession window, which lets you view supersession information for a highlighted part in text or on a Review List.

Transport
Displays part assemblies and assembly components for parts preceded by arrows in parts text.

The Image Menu
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Image On/Off
Hides an illustration so you can view all the text. Select Image On/Off again to redisplay the illustration.

Zoom
Expands and magnifies the current illustration. Click on the tool bar arrows to move around the illustration. Click the middle mouse button to return the illustration to its original size.

The Review List Menu
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View List
Displays a Review List for a transaction.

List Utility
Displays a menu which lets you clear, save, recall, copy, or delete a Review List.

User Added Part
Adds a part number, with an optional quantity and description, to a Review List.

Change Qty
Changes a part quantity on a Review List.

Retail Price
Hides or Displays the Dealer price on a Review List. 

The Help Menu
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Help Screen
Opens a window that explains what to do at the current screen.

FKey Map
Displays a list of function keys that are equivalent to the menu commands.

Using Function Keys

As an alternative to menu commands, you can use the top-row function keys, arrow keys, and other special keys to navigate. The "Function Key Display" utility lets you turn on or off the function key names at the bottom of the screen. Click directly on a displayed key to activate its function.
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The function keys activate special system features. The Function Key Window displays the top-row function key names.

Trnsport
Displays part assemblies and assembly components for parts preceded by arrows in parts text.

Catx
Displays the Catalog Index.

Secx
Displays the Section Index.

Figx
Displays the Figure Number/Illustration Index.

Srch
Lets you search for a part by number or name.

User Util
Displays the User Utilities menu for setting the function key display, the Review List price display and the VIN List display.

Filt
Opens the Filter Menu so you can set filters for parts displays. The Filter command and the FILT key are not available when you have entered a VIN. Clear the VIN to make them available.

Hist
Opens a Part History window, which lets you view history for a part in text or on a Review List.

VIN
Displays an “Enter Vehicle Identification Number or Option Code” prompt so you can type a complete VIN, the last eight characters of a VIN, or a three-character option code. If “VIN Decoding Display” is turned on in the User Utilities, you can also select a VIN from a list of previously used VINs.

Filt Togl
Enables or disables both manual and VIN filtering.

Clr Filt
Clears all previously set filters.

Img/Text
Hides an illustration so you can view all accompanying text. Press IMG/TEXT again to redisplay the illustration.

Zoom
Expands and magnifies the current illustration. Use the arrow keys to move around the illustration. Press ENTER to return the illustration to its original size.

Help
Opens a window that explains what to do at the current screen.

View List
Displays a Review List for a transaction.

Part Note
Displays the User Added Part Notes menu, which lets you add notes to part numbers; delete or change notes; and list or print all user-added part and location notes.

Supr
Opens a Supersession window, which lets you view supersession information for a highlighted part in text or on a Review List.

List Util
Displays a menu which lets you clear, save, recall, copy, or delete a Review List.

All
Redisplays all the parts text for a figure number which had previously been limited by find filters and/or callouts.

Add Part
Adds a part number, with a quantity and (optional) description, to a Review List.

Chg Qty
Changes a part quantity on a Review List.

Retl
Toggles the Dealer price display on a Review List ON and OFF. With both price columns displayed, using RETL [CF11] hides the Dealer Prices. Using RETL [CF11] again displays both the Retail and the Dealer prices.

Loc Note
Displays the Location Notes menu, which lets you add your own notes to specific screens; view, change, or list those notes; and list or print all part and location notes.

Clos
Exits the application.

Insert
Marks a part number with an * and adds the part to a Review List.

Delete
Deletes the * from an entry so the part does not appear on a Review List.

Home
Displays a “Find” prompt for filtering on Restriction/Remarks column information.

Backspace
Deletes the character to the left of the cursor.

Enter
Use the ENTER key (labeled RETURN on some keyboards) which is located above the right SHIFT key. Do not use the numeric keypad ENTER.

Page Up
Pages forward through illustrations.

Page Down
Pages back through illustrations.

Up, Down Arrows
Move the cursor up and down through text.

Right, Left Arrows
Move between text pages, multi-page index pages, and Help window pages.

Using the Keyboard

If you prefer, you can press the corresponding keys on the keyboard. Each top-row function key is used either by itself or along with another key. "F3 Catx", for example, indicates to press the F3 key to open the Catalog Index. "CF1 Zoom" indicates to hold down the CTRL key and press the F1 key to activate the Zoom function. "AF4 Clos" indicates to hold down the ALT key and press the F4 key to close (exit) the application.

Using the Tool Bar
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Printer Icon
Displays the Print dialog box.

Arrows
Move the cursor up and down through text. Move between pages of text and indexes. 

<< >>
Page through illustrations.

Reverse Arrow
Performs the same function as the right mouse button or the ENTER key.

Magnifier
Expands and magnifies an illustration.

Using the Mouse

The mouse is your primary means of selecting items from the screen. If you have little or no experience with a mouse, the following information may be helpful.xe "Mouse:Using"
[image: image16.png][





Mouse Buttons

Right Button
On illustrations, functions as a magnifying glass. Move the on-screen mouse pointer to an area of the illustration. Then press and hold down this button to magnify that area. On text, functions as the ENTER key.

Left Button
Click on pull-down menu commands or icons to activate application functions. Click on list box entries and index entries to identify items for searches. Click on text entries to select parts.

Basic Mouse Techniques

Click
Move the on-screen mouse pointer to an item and quickly press and release the left mouse button.xe "Clicking on Items with a Mouse"

xe "Mouse:Clicking"

Double-Click
Move the on-screen mouse pointer to an item and click the left mouse button twice in rapid succession.xe "Double-Clicking with a Mouse"

xe "Mouse:Double-Clicking"

Right-Click
Move the on-screen mouse pointer to an item and quickly press and release the right mouse button.xe "Right-Clicking with a Mouse"

xe "Mouse:Right-Clicking"

Drag
Press and hold down the left mouse button while moving the mouse.xe "Dragging with a Mouse"

xe "Mouse:Dragging"

2   Search for Parts

Using Indexes 

1.
The Catalog Index appears when you select an Isuzu application by clicking on the Desktop icon or by clicking on the Start button, selecting "Programs", selecting "Isuzu Worldwide" to open a submenu, and then selecting "Isuzu Worldwide" from the submenu. This is the starting point for a part search.
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· Select Catalog Index from the Goto menu or use the CATX key to redisplay this index when you want to change catalogs.

· Each catalog entry shows a five-character catalog code, a catalog name, and an associated range of years.

2.
Select a catalog by clicking on an entry with the mouse pointer or by typing the five-character code and pressing ENTER.

3.
If the catalog you are searching for resides on a CD that is not in your CD drive, the Missing CD/DVD window appears:
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4.
Insert  the correct CD into the drive. The last digit  of the CD name tells you which CD to insert.

5.
Select 50808, for example, to display the Section Index.
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· Select Section Index from the Goto menu or use the SECX key to return to this index from other screens.

· Pressing ENTER at the Figure Number/Illustration Index also returns you to this index.
6.
Select a section by clicking on an entry with the mouse pointer or by typing the one-character code and pressing ENTER. Select “2 Clutch/Transmission/Trans Axle”, for example, to display a Figure Number/Illustration Index.

· Select Figure Index from the Goto menu or use the FIGX key to return to this index from other screens.

· Pressing ENTER at this index redisplays the Section Index.

· When a figure number has more than one associated illustration, use the tool bar >> and << or the PAGE UP and PAGE DOWN keys to scroll through the mini-illustrations.
· To page between sections, hold down the CTRL key and press PAGE UP or PAGE DOWN.

7.
Select a figure number (“01 Clutch”, for example) or a mini-illustration (“2-01 Clutch”) to display an illustration with its corresponding text. Make your selection by one of the following methods:
· Click on it with the mouse pointer.

· Type the two-character number and press ENTER. If you type a number that begins with a zero (01, for example), you must type the zero.

Viewing an Illustration

When you select an entry from a Figure Number/Illustration Index, the illustration appears on top of its corresponding text.
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To magnify the illustration for easier viewing, use Zoom. Use the arrow keys to move around the illustration. Click on the middle mouse button or press ENTER to return the illustration to its original size. To magnify a section of the illustration, move the mouse pointer to that section and hold down the right mouse button.

When a figure has more than one illustration, use the tool bar >> and << or the PAGE UP and PAGE DOWN keys to page between illustrations.

To return to the Figure Number/Illustration Index from a text/illustration screen, press ENTER.
Viewing Text for an Illustration

To hide the illustration so you can view the full text display, select Image On/Off from the Image menu or use the IMG/TEXT key.

The Part Text Heading

The part text heading and text itself are arranged as follows:

Top line
Section and illustration
2-01 CLUTCH

2nd line
Applied models for specified catalog
A = M/T MSB5S (R45)

3rd, 4th, and 5th lines
Column headings for part text
KEY --- PARTNAME:

1 --- 00.886 DISC; CLUTCH

8-Digit Part Number (97013548). 10-Digit Part Number (8-97013-548-0), ITC, Applied Date (9811-), L/R, QTY (01), Applied Model (A 4JB1 ENG RLF) / Restriction / Remarks

Part Text Indicators

A page indicator appears under the parts text, showing “Top of List”, “More”, or “End of List”. “Top of List” appears in the lower left corner of the sample screen on the previous page.

To the right of the page indicator is a records indicator, showing the number part text records available for the figure.

To the right of the records indicator is an illustration indicator, indicating whether more than one illustration exists for the figure and, if so, which one you are viewing (Image 1 of 3, for example).
Part Text Scrolling

Use the tool bar up and down arrows or the up and down arrow keys to scroll through text line by line. If more than one page of text is indicated, use the tool bar right and left arrows or the right and left arrow keys to move between pages.

Selecting Parts

To display information for a callout on an illustration, click on the item number or type the item number and press ENTER. Then click the middle mouse button or press ENTER again. To display information for more than one item, click on several items or type several item numbers, pressing the comma (,) key, the spacebar, or ENTER after each. Then click the middle mouse button or press ENTER again.

To delete a callout number selected by mistake, use the BACKSPACE key.

If you need to see the full text display again, select All from the Find menu or use the ALL key.
To select a part for a Review List, double-click on the part entry to insert an asterisk (*) next to the entry and add it to your list. Or, highlight the entry and use the INSERT key. 

If you decide not to add the part to your list, click on the entry again or use the DELETE key to remove the asterisk (*).

Searching by Part Number

The Find menu’s Search command and the SRCH key open a Search window and display a prompt for making a part number search.

Searching Across All Catalogs

If you select Search at the Catalog Index, a Global Search window opens with a “Part Number” prompt for searching across all catalogs. For example, type 1-09070-039-0 (with or without the dashes) and press ENTER at the prompt to display the following:
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When the page indicator shows, for example, “Page 1 of 3”, use the tool bar right and left arrows or the right and left arrow keys to page between screens.

Click on an entry (or use the tool bar up and down arrows or the up and down arrow keys to highlight an entry and press the INSERT key) to display the applicable part text and illustration. You can then select a part for your Review List.

Searching Within a Catalog

When you select Search within a catalog, a Catalog Search window opens with a “Part Name/Number” prompt, narrowing your search to one catalog. For example, with the 10669 catalog selected, type 1-09070-039-0 (with or without the dashes) and press ENTER at the prompt to display the following:
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When the page indicator shows, for example, “Page 1 of 3”, use the tool bar right and left arrows or the right and left arrow keys to page between screens.

Click on an entry (or use the tool bar up and down arrows or the up and down arrow keys to highlight an entry and press the INSERT key) to display the applicable part text and illustration. You can then select a part for your Review List.

Notice that a global search on part number 1-09070-039-0 produced 3 records. A search on that same part number within the 10669 catalog produced 1 record.

Searching by Part Name

After selecting a catalog, the Find menu’s Search command and the SRCH key open a Catalog Search window with a “Part Name/Number” prompt, for making a part name search. A name search takes you to a list of illustrations for the name you type. From that listing, you can select an entry that takes you to part text and an illustration.

Typing a Descriptive Word

For example, with the 10669 catalog selected, type CAM and press ENTER at the prompt to display the following:
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The window lists illustrations which include the descriptive terms “cam”, “camber”, and “camshaft”. Click on an entry (or use the tool bar up and down arrows or the up and down arrow keys to highlight an entry and press the INSERT key) to display part text and an illustration with the applicable callout highlighted. You can then click on the part entry to insert an asterisk (*) and select the part for your Review List.

Typing Additional Descriptive Words

You can type additional descriptive terms to narrow your search. Use a comma (,) to represent the word “and”; use a slash (/) to represent the word “or”. You can use up to four “and’s” and one “or” in one search.

For example, typing CAM,GEAR and pressing ENTER at the “Part Name/Number” prompt narrows your search to one figure.
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Click on the entry (or use the tool bar up and down arrows or the up and down arrow keys to highlight an entry and press the INSERT key) to display part text and an illustration with the applicable callout highlighted. You can then click on the part entry to insert an asterisk (*) and select the part for your Review List.

Notice that without the additional descriptive word "gear", you had to search through list of 30 entries which included "cam" to find this figure. Typing additional descriptive words will not always narrow your search to the one figure you need, but it will make your search considerably more manageable.

Displaying History for a Part 

History is available in part text and on Review Lists. To view history for a part, highlight the entry and select History from the Part Info menu or use the HIST key. A Part History window will open. The window for part number 0-10805-850-0, for example, appears as follows:
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The Part History window consists of anywhere from one to five columns. At the top of each column is the “head of the family” part number. “Family members” are listed below by group. Each entry shows the part number and ITC (interchange) code (the same code listed in the ITC column in part text), which shows the history code for the part:

H
The part is the current, orderable “head of the family”.

A
The current and new part numbers are mutually interchangeable.

C
The new part number can replace the current part number, but the current part number cannot replace the new part number.

In each column, the top part number is the “head of the family”, with superseded parts listed below it in the order in which they became part of the chain. The part you highlighted for viewing history is preceded by “>>>”.

When there are more parts than a column can display at one time, you can use the arrow keys to scroll through them individually.

Up and Down Arrows
Scroll up and down each column line-by-line.

Right and Left Arrows
Move between pages of parts in a column.

PAGE UP and PAGE
DOWN KEYS
Move between columns.

To select a part from a Part History window for a Review List, highlight it and click with the left mouse button or highlight it with the arrow keys and press the INSERT key. An asterisk will be inserted in front of the entry to indicate it has been selected for the list. If you decide not to add the part, click on the entry again or press the DELETE key with the entry highlighted to remove the asterisk (*).

If a part has history information, a message will indicate that history is available when you add that part to a Review List. The asterisk (*) preceding a part with history on a Review List blinks in reverse video.

When you use the History command or HIST key with a part that has no history, the message “This Part Has No History Information” will appear.

To exit the Part History window, press ENTER.

Displaying Supersession Information
for a Part 

To view supersession information for a part in part text, highlight the entry and select Supersession from the Part Info menu or use the SUPR key. A Supersession window will open. The window for part number 1-51385-001-0, for example, appears as follows:
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The part number you highlighted appears after “Supersession for part”. Parts in the supersession chain are listed below this number. “Top of List” indicates that the list fills more than one window. Use the arrow keys to page between windows.

To select a listed part, double-click on the entry or use the arrow keys to highlight it and press the INSERT key.

When you finish viewing supersession information, press ENTER to close the window.

Finding Assembly Parts

Use the Transport feature to find assembly part information.
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A right arrow preceding an entry indicates the part is an assembly.

When you transport from an assembly part number (in this example, 1-81200-249-3) to the components’ figure number, the assembly part number is filtered on.

Click on the entry to highlight it (in this example, the entry under "Generator ASM") and select Transport from the Part Info menu or press the TRNSPORT key to display the component parts.
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A left arrow preceding an entry indicates the part is an assembly component.

“A = 1-81200-249-3” is set as the filter, limiting the parts display to the components of the “A” assembly.

You can select All from the Find menu or use the ALL key to redisplay all the component parts for the figure number.

To view the assembly (in this example, a generator assembly from Figure 0-60) highlight the part entry and select Transport.

Taking a Shortcut

When you already know the number of an illustration you want, you can take a shortcut to go directly to the specific text/illustration display without selecting entries from the intervening indexes. In the case of a multipage illustration, you can include the page number (in the form 01, 02, etc.) as well. You can also use a shortcut to change the catalog from any screen. Type shortcuts in the following format:

[catalog code] [section number] [dash] [illustration number] [page number] [ENTER]

Example: Displaying a Clutch Illustration

From the Catalog Index: Type 105852-01 and press ENTER to display the clutch illustration. In this example, 10585 is the catalog code, 2 is the section number, and 01 is the illustration number.

From the Section Index: Type 2-01 and press ENTER to display the clutch illustration. In this example, 2 is the section number, and 01 is the illustration number.

Example: Changing Catalogs

From any screen in the current catalog, type 106317-50 and press ENTER to display the 10631 catalog's front seat illustration.

In this example, 10631 is the catalog code, 7 is the section number, and 50 is the illustration number.

3   Use Manual Filters, VIN Filters, and Option Codes
Filtering Parts Manually

Use the Filter feature to manually enter parts filters. Once filters are set, a parts search retrieves fewer entries for you to read through to find the specific part you need.

The Filter command and the FILT key are not available when VIN filtering is active. Use the Find menu’s Filter Toggle command or the FILT TOGL key to enable or disable manual part filtering.
Filtering by Applied Model Codes

This sample text/illustration display shows 172 part records resulting from an unfiltered search.
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To narrow the search, select Filter from the Find menu or use the FILT key to display a filtering screen.

[image: image30.png]Enter Filter> I Transnission
MJMU M/T(XGE)

Production Date(HHYY/MMYYYY)  MJA7T M/T(R6F)

RT11609R M/T FULLER(PA4)

Engin RT014 613 H/T _FULLER(HRU)
gﬁgl TURBH(ENE(]]L) RT14715 W/T FULLER(ZSL)
BRATTC ENG(19L) Wheelbase

10PCT STD ENG(10L) WHEEL BASE 6700HH (67W)
10PD1 STD ENG(40L) WHEEL BASE 7100MM (714)

Final Gear Ratio
FINAL GEAR 39,

FINAL EERR 43/11 17 5“(”48)

Hodel Desianator
CXH(CXH5HF)





Click on a code or type a code at the "Enter Filter" prompt and press ENTER to activate the filter and reduce the number of parts to search through.

Clearing a Filter

To clear a filter, display the filtering screen and select Clear All Filters from the Find menu or use the CLR FILT key. You can also clear filters by using the Goto menu’s Catalog Index command or the CATX key to return to the Catalog Index.

Filtering by Callout

You can use an illustration callout as a temporary filter to display only information related to that record.

To select a callout, click on its number on the illustration or type the number at the “Callout” prompt and press ENTER.

To filter on multiple callouts, click on their numbers one at a time or type the numbers, pressing the comma (,) key, space bar, or ENTER after each. When you finish selecting callouts, press the middle mouse button or press ENTER.

To deselect a callout number selected by mistake, use the BACKSPACE key.

Callout filtering is temporary. The filter is removed when you leave the text/illustration display.
Filtering by Restriction/Remarks Column Qualifiers

You can use information shown in the Restriction/Remarks column to filter parts text.

Press the HOME key to display a “Find” prompt in the Navigation window. Type the word you want to use as a filter and press ENTER. Only part records containing the that word will be displayed.

For example, typing washer and pressing ENTER limits the display to only part records containing the word “washer” in the Restriction/Remarks column. As a result, the number of records displayed is reduced.

Restriction/Remarks column filtering is temporary. The filter is removed when you leave the text/illustration display.

Filtering Parts with a VIN

Typing a VIN sets the following major option code part filters, if available: model designator, engine, transmission, grade, wheelbase, final gear ratio, and production date. VIN filters remain active until you change catalogs or type a different VIN. You cannot filter parts manually with the Filter command and the FILT key when VIN filtering is active.

Typing a VIN

Select VIN Decoding from the Information menu or use the VIN key to display a prompt.

Enter Vehicle Identification Number or Option Code >

At this prompt you can type a complete VIN, the last eight characters of a VIN, or a three-character option code. If “VIN Decoding Display” is turned on in the User Utilities, you can also select a VIN from a list of previously used VINs. When you enter a VIN, it is displayed in the Navigation Window.

Typing a Complete VIN

At the "Enter Vehicle Identification Number or Option Code > prompt, type a 17-character VIN and press ENTER to display a VIN window. The window shows the decoded VIN and option codes for the vehicle. A “Setting Catalog to” indicator shows the catalog which will be set when you press ENTER to close this window.

Typing the Last 8 Characters of a VIN

If you type the last eight characters of a VIN at the “Enter Vehicle Identification Number or Option Code” prompt, an additional window displays all VINs matching those last eight characters. Choose a VIN from the list to display VIN information.

Selecting VINs from a List

If “VIN Decoding Display” is turned on in the User Utilities, a list of previously selected VINs appears below “VIN LOG” in the WIN window. To select a VIN from this list, click on a VIN to display the VIN window for that VIN. If you want to display descriptions of option codes from a VIN window, follow the procedure under “Displaying Option Codes”. When you finish at the VIN window, press the middle mouse button or press ENTER to close the window and set the catalog as shown by the “Setting Catalog To” indicator.

Clearing and Toggling Filters

You can use the Find menu’s Filter Toggle command or the FILT TOGL key to disable and re-enable VIN filtering and manual part filtering. You can clear a VIN filter by selecting Catalog Index from the Goto menu or using the CATX key to display the Catalog Index.

Using Option Codes

Displaying Option Codes

1.
After opening a VIN window, select Option Codes from the Information menu or use the OPT CODE key to display a list of descriptions of all available option codes for the selected VIN.

“Top of List” indicates more option code descriptions are listed.

2.
Use the right and left tool bar arrows or the arrow keys to scroll through the complete list.

3.
To display a description of a specific option code, click directly on the code in the VIN window or type the code at the “Enter Vehicle Identification Number or Option Code” prompt.

4.
When you finish displaying option code descriptions, press the middle mouse button or press ENTER to close the VIN window and set the catalog shown by the “Setting Catalog To” indicator.
Viewing Option Codes in Part Text

When you have entered a VIN, the applicable option codes are highlighted in part text.

4  Accumulate a List

Displaying a List

Select View List from the Review List menu or use the VIEW LIST key to open your Review List. For example:
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When “Top of List” appears, use the right and left arrow keys to page between screens.

A “D” in front of an entry indicates the part has been selected twice. To delete a duplicate entry, follow the procedure under “Removing Parts from a List”.

A highlighted asterisk (*) preceding a part number indicates that the part has history. To view history, follow the procedure under “Displaying History for Parts on a List”.

For parts that have supersession information available, follow the procedure under “Displaying Supersession Information for Parts on a List”.

Retail and Dealer prices are also displayed on the Review List. To toggle prices ON or OFF, follow the procedure under “ Displaying Prices in a Review List.” 

After reviewing and modifying your list, click the middle mouse button or press ENTER to remove the list from the screen.

Displaying Prices in a Review List

The default setting for the Review List prices is ON. To turn pricing to OFF, do the following:

1. Press F7 or click the USER UTIL [F7] key to display the User Utilities screen:

[image: image32.png]User Utilities

1. Function Key Display........oeeeverennenananns ON

2. Prices on Review List..

3. Vin Decoding Display.......ceeiererennenannnns ON

4. Current display language............ceveenennnn English





2. Click 2. Prices on Review List to toggle pricing to OFF. Click it again to turn pricing back ON.  

Both Retail and Dealer prices will now appear for each item on the Review List. To hide the Dealer prices from view press Ctrl+F11 or click the RETL [CF11] key.

NOTE: Review List pricing columns for users who have not subscribed to pricing will contain zeros. To hide the columns from view, use the above procedure to toggle pricing to OFF.

Clearing, Saving, Recalling, Copying,
and Deleting a List

1.
Select List Utility from the Review List menu or use the LIST UTIL key to display the Review List Options menu.

[image: image33.png]- Clear The Current List.
- Save The Current List.
- Recall A Saved List.

- Copy A Saved List.

- Delete A Saved List.

ENERE ISP VN

- Save The Current List To Floppy.
Enter Option:





2.
Click on an option.

3.
To remove the menu from the screen, click the middle mouse button or press ENTER.

Clearing a List

“Clear the Current List” clears the current Review List (an unsaved list in progress). Select option 1 from the Review List Options menu. “The Review List has been cleared” appears under the Navigation window.

Saving a List

“Save the Current List” saves the current Review List with a User ID and Transaction ID for future retrieval. A User or Transaction ID can include up to eight characters.

1.
Select option 2 from the Review List Options menu to display a “User” prompt and a list of previously saved User IDs.

2.
Click on an existing User ID or type a new User ID and press ENTER to display a “Transaction” prompt and a list of transactions previously saved under that User ID.

· If the list of existing User IDs fills more than one screen, use the tool bar right and left arrows or the right and left arrow keys to page between screens.

· If you type a new ID, you may want to use your initials or employee number.

3.
Click on a Transaction ID or type a new Transaction ID and press ENTER. “Transaction as been saved: [Transaction ID]” appears under the Navigation window.

· If the list of existing Transaction IDs fills more than one screen, use the tool bar right and left arrows or the right and left arrow keys to page between screens.

· If you type a new ID, you may want to use a customer name, customer number, or repair order number.

· If you select one of the listed IDs, the following prompt appears: “Are you sure you want to overwrite this transaction?” To replace the existing list with the new one, click on Yes or type Y.

Recalling a List

“Recall a Saved List” retrieves a previously saved Review List and makes it the current list. If you have a list in progress (not saved), it will be cleared.

1.
Select option 3 from the Review List Options menu to display a “User” prompt and a list of previously saved User IDs.

2.
Select a User ID to display a “Transaction” prompt and a list of transactions saved for that User ID.

3.
Select the Transaction ID you want to recall. “Transaction has been recalled: [User ID] [Transaction ID]” appears under the Navigation window.

If you modify this list and save it under the same Transaction ID, the following prompt appears: “Are you sure you want to overwrite this transaction?” To replace the existing list with the modified one, click on Yes or type Y.

Copying a List

“Copy a Saved List” copies a Review List previously saved under one User ID to another User ID. The original list remains under its original User ID. You can put the copied list under (1) the same User ID with a new Transaction ID; (2) a new User ID and new Transaction ID; or (3) a new User ID with the same Transaction ID. If you have an unsaved list in progress, the copied list will not overwrite it.

1.
Select option 4 from the Review List Options menu to display a Copy from User ID window with a “User” prompt and a list of previously saved User IDs.

2.
Select the User ID from which you wish to copy the list to display a Copy from Transaction window with a “Transaction” prompt and a list of transactions saved for that User ID.
3.
Select the Transaction ID from which you want to copy the list to display a Copy to User ID window with a “User” prompt and a list of previously saved User IDs.

4.
Type a User ID to which you wish to copy the list to display a Copy to Transaction window with a “Transaction” prompt and a list of transactions previously saved under that User ID.
5.
Type a Transaction ID and press ENTER. “Transaction has been copied: [User ID] [Transaction ID]” appears under the Navigation window.

Deleting a List

“Delete a Saved List” permanently deletes a previously saved Review List. When you delete all transactions under a User ID, that User ID is also deleted. This option deletes previously saved lists only. If you want to delete both the current list and a saved list, use both “Clear the Current List” and “Delete a Saved List”. It does not matter which you use first.

1.
Select option 5 from the Review List Options menu to display a Delete User ID window with a “User” prompt and a list of previously saved User IDs.

2.
Select the User ID from which you want to delete a transaction to display a Delete Transaction window with a “Transaction” prompt and a list of transactions saved under that User ID.

3.
Select the Transaction ID you want to delete. “Are you sure you want to delete this transaction?” appears.

4.
Click on Yes or type Y. “Transaction has been deleted: [Transaction ID]” appears under the Navigation window.

Saving a List to a Diskette

“Save the Current List to Floppy” saves a Review List to a diskette instead of the system’s hard disk.

1.
Insert a diskette into the floppy disk drive.

2.
Select option 6 from the Review List Options menu to open a Save to User ID window with a “User” prompt.

3.
Type a User ID and press ENTER to open a Save Transaction window with a “Transaction” prompt.

4.
Type a Transaction ID and press ENTER. The list will be copied to the diskette and “Transaction has been saved: [Transaction ID]” will appear below the Navigation Window.

Adding Parts to a List

1.
Select User Added Part from the Review List menu or use the ADD PART key to display an “Enter Part Number” prompt in the Navigation window.

2.
Type the part number (with or without dashes) and press ENTER. An “Enter Quantity” prompt appears. 

3.
Type a quantity and press ENTER. A “Description” prompt appears.

You can type any number up to 999. Or you can press ENTER without typing a quantity. The system will automatically enter a quantity of 1.

4.
Type an (optional) description and press ENTER. The “Enter Part Number” prompt reappears.

Type a maximum of 50 characters. Or you can press ENTER without typing a description to omit a description.

5.
If you want to add another part number to your list, type the number at the prompt. If not, press ENTER to remove the prompt from the screen.

The system will supply the quantity and description on the Review List. If you entered a quantity and description, they will appear on the list.

Removing Parts from a List

To remove a part from a list, use one of the following methods:

Double-click on the entry to remove the * or D (indicating a duplicate part) preceding the part number. Then click the middle mouse button to remove the list from the screen. The next time you click on View List, the part number will be gone.

Use the arrow keys to highlight the entry and press the DELETE key to remove the * or D (indicating a duplicate part) preceding the part number. Then press ENTER to remove the list from the screen. The next time you use the VIEW LIST key, the part number will be gone.
Changing Quantities on a List

1.
Click on a part entry for which you want to change the quantity. Or use the arrow keys to highlight it.

2.
Select Change Qty from the Review List menu or use the CHG QTY key to display a “Change Qty” prompt in the Navigation Window.

3.
Type the new quantity (any number between 1 and 999) and press ENTER to change the displayed quantity.

Changing the Price Display on a List

1.
Select Retail Price from the Review List menu or use the RETL key [CF11] either before or after selecting View List from the menu or using the VIEW LIST key [CF4].

2.
When both Retail and Dealer prices are displayed, select Retail Price or use RETL [CF11] to hide the Dealer prices.

3.
Select Retail Price or use RETL [CF11] again to display both price columns.

Printing a List

Select Print from the File menu or use the CTRL+P key combination to print a Review List. If the list contains more than one page, all pages are printed. A list is printed as displayed.

Displaying History for Parts on a List

History is available in part text and on Review Lists. To view history for a part, highlight the entry and select History from the Part Info menu or use the HIST key. A Part History window will open. The window for part number 0-10805-850-0, for example, appears as follows:
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The Part History window consists of anywhere from one to five columns. At the top of each column is the “head of the family” part number. “Family members” are listed below by group. Each entry shows the part number and ITC (interchange) code (the same code listed in the ITC column in part text), which shows the history code for the part:

H
The part is the current, orderable “head of the family”.

A
The current and new part numbers are mutually interchangeable.

C
The new part number can replace the current part number, but the current part number cannot replace the new part number.

In each column, the top part number is the “head of the family”, with superseded parts listed below it in the order in which they became part of the chain. The part you highlighted for viewing history is preceded by “>>>”.

When there are more parts than a column can display at one time, you can use the arrow keys to scroll through them individually.

Up and Down Arrows
Scroll up and down each column line-by-line.

Right and Left Arrows
Move between pages of parts in a column.

PAGE UP and PAGE
DOWN KEYS
Move between columns.

To select a part from a Part History window for a Review List, highlight it and click with the left mouse button or highlight it with the arrow keys and press the INSERT key. An asterisk will be inserted in front of the entry to indicate it has been selected for the list. If you decide not to add the part, click on the entry again or press the DELETE key with the entry highlighted to remove the asterisk (*).

If a part has history information, a message will indicate that history is available when you add that part to a Review List. The asterisk (*) preceding a part with history on a Review List blinks in reverse video.

When you use the History command or HIST key with a part that has no history, the message “This Part Has No History Information” will appear.

To exit the Part History window, press ENTER.

Displaying Supersession Information
for Parts on a List

To view supersession information for a part on a Review List, highlight the entry and select Supersession from the Part Info menu or use the SUPR key. A Supersession window will open. The window for part number 1-51385-001-0, for example, appears as follows:

[image: image35.png]Supersession for part 1-51385-001-0
Hodel LR Qty Part Hame

04+ 1 SEAT; SPR,LUR

U-BOLT SET; RR SPRING (L=305)
COVER; SPR SEAT

BOLT; CONNECTOR (MBX16)
MRSNER LK,0IL PAN (ID=8.2)

SERT " SPR,LUR

U-BOLT SEF; RR_SPRING (L=325)
COVER; SPR SEAT

BOLT; CONNECTOR (MBX16)
MRSNER LK,0IL PAN (ID=8.2)

SERT " SPR,LUR

U-BOLT SEF; RR_SPRING (L=305)
COVER; SPR SEAT

BOLT; CONNECTOR (MBX16)
MRSNER LK,0IL PAN (ID=8.2)

sunFTf TRUBHION, RR SUSP

PLRTE SIDE, TRUNHION SHAFT
PIN; SIDE PLRTE Tﬂ SHAFT

BOLY: “BRKT T0 FRA

VASHER; LK,SPR SETTINE (1D=18)

Part Hunber

RIS 0 3 b 3 8 3 e s ]

9-1 09150 618-0

Remarks

EACEPT_HEAUY DUTY

ﬂPTIﬂN CODES G50/G51/52
G THE TRANION SHAFT

EXCEPT P/H 9513810353

FOR_HEAYY DUT

OPTION SODES 650/651/SX2
HAVING THE TRANION SHAFT
EXCEPT P/ 9513810353

EXCEPT HEAUY DUTY
OPTION CODES G56/651/5%2
ggg HG TNE TRANION SHAFT P/H





The part number you highlighted appears after “Supersession for part”. Parts in the supersession chain are listed below this number. “Top of List” indicates that the list fills more than one window. Use the arrow keys to page between windows.

To select a listed part, double-click on the entry or use the arrow keys to highlight it and press the INSERT key.

When you finish viewing supersession information, press ENTER to close the window.

5  Additional Features

Appending Notes to Part Numbers

With part text displayed, click on a part entry or use the arrow keys to highlight it. Then select Part Note from the Part Info menu or use the PART NOTE key to display the User Added Part Notes menu.
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Adding a Part Note

You can attach up to five notes to a part number.

1.
Click on the part entry to which you want to add a note (or use the arrow keys to highlight the entry) and select option 1 from the User Added Part Notes menu to display an “Enter Text” prompt.

2.
Type the note and press ENTER.

3.
Press ENTER again to attach the note to all parts which have that number.

Deleting a Part Note

1.
Click on the part entry from which you want to delete a note (or use the arrow keys to highlight the entry) and select option 2 from the User Added Part Notes menu to display the Delete Note window. If additional notes are attached to an entry, they are listed in a window.

2.
Click on the entry you want to delete or type its number and press ENTER to remove it from the Delete Note window.

3.
If you want to delete any other notes from the window, do so at this time.

4.
When you finish deleting notes from the window, click the middle mouse button or press ENTER to close the window.

5.
Click the middle mouse button or press ENTER again or redisplay the part text without the note. The note will be removed from all parts which have that number.

Modifying a Part Note

1.
Click on the part entry for which you want to change a note (or use the arrow keys to highlight the entry) and select option 3 from the User Added Part Notes menu to open the Change Note window. If additional notes are attached to an entry, they are listed in a window.

2.
Click on the note you want to modify or type its number and press ENTER to display the “Enter Text” prompt, followed by the note you selected.

3.
Use the BACKSPACE key to delete all or part of the original note.

4.
Type the new note and press ENTER.

5.
Press ENTER again to attach the revised note to the part number.

If additional notes are attached to a part entry and you want to modify some or all of them, repeat this procedure for each note you want to change.

Listing all Part and Location Notes

1.
Select option 4 from the User Added Part Notes menu to display the User Added Notes window. This window lists all user-added part and location notes currently stored on the system. An asterisk (*) precedes each note. When a list fills more than one screen, use the right and left arrows for paging.

2.
To remove a note from this window, double-click on the entry or use the arrow keys to highlight it and press the DELETE key. The asterisk (*) preceding the note will disappear. If you want to delete any other notes from the window, do so at this time.

· Each note that does not have an asterisk will be deleted when you leave this screen.

· If you deselect a note by mistake, click on it again or use the INSERT key to reinsert the asterisk.

3.
Click the middle mouse button or press ENTER to delete the deselected note and redisplay the User Added Notes window.

4.
Click the middle mouse button or press ENTER again to remove the menu from the screen.
Printing All Part and Location Notes

1.
Select option 5 from the User Added Part Notes menu to display a prompt.

Would you like to print all notes? (Y/N)
2.
Click on Yes or type Y and to open the Print dialog box.

3.
Click on “OK” to print all user-added part and location notes.

Appending Notes to Screens

Use these procedures to append a note to a screen at a specific location in the application. You can view, modify, delete, list, and print notes at a screen which shows “Location Notes Are Available” in the Navigation Window.

Select Location Note from the Information menu or use the LOC NOTE key to display the User Added Location Notes menu.
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Viewing Location Notes

1. 
At a screen showing “Location Notes Are Available” in the Navigation window, select option 1 from the User Added Location Notes menu to display a list of location notes for the screen.

2.
When you finish viewing notes, click the middle mouse button or press ENTER to redisplay the User Added Location Notes menu.

3.
Click the mouse button or press ENTER again to remove the menu from the screen.

Adding a Location Note

You can attach up to five location notes to a screen.

1.
At the screen to which you want to attach a location note, select option 2 from the User Added Location Notes menu to display an “Enter Text” prompt.

2.
Type a note and press ENTER to attach your note to the screen. “The user note has been added to the system” appears below the Navigation Window.

3.
Press ENTER to remove the Location Notes menu from the screen.

Deleting a Location Note

1.
At the screen from which you want to delete a location note, select option 3 from the User Added Location Notes menu to display the Delete Note window. 

2.
Click on the entry you want to delete or type its number and press ENTER to remove it from the Delete Note window. “The user note has been deleted from the system” appears below the Navigation Window.

3.
If you want to delete any other notes from the window, do so at this time.

4.
When you finish deleting notes from the window, click the middle mouse button or press ENTER to close the window.

5.
Click the middle mouse button or press ENTER again to close the User Added Location Notes menu.

Modifying a Location Note

1.
At the screen at which you want to modify a location note, select option 4 from the User Added Location Notes menu to display the Change Note window.

2.
Click on the note you want to modify or type its number and press ENTER to display the “Enter Text” prompt, followed by the note you selected.

3.
Use the BACKSPACE key to delete all or part of the original note.

4.
Type the new note and press ENTER. “The user note has been changed on the system” appears below the Navigation Window.

5.
Press ENTER again to attach the revised note to the screen.

If additional notes are attached to a screen and you want to modify some or all of them, repeat this procedure for each note you want to change.

Listing all Part and Location Notes

1.
Select option 5 from the User Added Location Notes menu to display the User Added Notes window. This window lists all user-added part and location notes currently stored on the system. An asterisk (*) precedes each note. When a list fills more than one screen, use the right and left arrows for paging.

2.
To remove a note from this window, double-click on the entry or use the arrow keys to highlight it and press the DELETE key. The asterisk (*) preceding the note will disappear. If you want to delete any other notes from the window, do so at this time.

· Each note that does not have an asterisk will be deleted when you leave this screen. 

· If you deselect a note by mistake, click on it again or use the INSERT key to reinsert the asterisk. 

3.
Click the middle mouse button or press ENTER to delete the deselected note and redisplay the User Added Notes window.

4.
Click the middle mouse button or press ENTER again to remove the menu from the screen.
Printing All Part and Location Notes

1.
Select option 6 from the User Added Location Notes menu to display a prompt.

Would you like to print all notes? (Y/N)
2.
Click on Yes or type Y and to open the Print dialog box.

3.
Click on “OK” to print all user-added part and location notes.

Selecting User Utilities

The User Utilities let you customize certain system features. Select User Utility from the File menu or use the USER UTIL key to display the User Utilities menu. Click on an option or type the option number to toggle to the opposite setting.
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Function Key Display
Use this utility to toggle the setting that determines whether or not the names of the function keys appear at the bottom of the screen. If you change the setting, exit and reopen the Isuzu application to make the change take effect.

Prices on Review List
Use this utility to display Dealer and Retail prices on the Review List. The default setting is ON. When the prices are toggled to ON, you can use the RETL key [CF11] to hide the Dealer prices. NOTE: Review List pricing columns for users who have not subscribed to pricing will contain zeros. To hide the columns from view, toggle pricing to OFF.

VIN Decoding Display
Use this utility to toggle the setting that determines whether or not the VIN window is displayed after you type a VIN.

Current Display Language
Use this utility to toggle the setting that determines whether certain on-screen text features are displayed in English or German. All catalogs show prompts, pull-down menu commands, and the Function Key Display in the selected language. Some catalogs also show part names, section names, figure titles, and remarks in either language. Other catalogs currently show this text in English only, regardless of the language setting. In addition, Help information is currently displayed in English only. Eventually, all these on-screen text features will be available in both English and German. If you change the setting, exit and reopen the Isuzu application to make the change take effect.

A  Windows 95/98

Performing Monthly Updates

1.
Close all programs and exit to the Windows Desktop. Insert the new Isuzu Worldwide CD #1 into a CD drive.

2.
Click on the Start button to open the Start menu.

 XE "Backing Up Information:Windows 95" 

 XE "Windows 95:Backing Up Information" 3.
Click on Run to open the Run dialog box.

4.
In the Run dialog box, do one of the following:

4.1
In the “Open” field, type D:\Setup.exe. Then click on OK.
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Note: Substitute your CD drive letter for “D:” in this example.

4.2
Click on the Browse button and browse to the drive containing the Isuzu Worldwide CD. Click on Setup.exe. With this file path displayed in the “Open” field, click on OK.

5.
When the Select Language dialog box appears, select your preferred language, English or German, and click on Next.
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6.
If you do not have Java installed on your computer it will be installed now.

7. 
When the Welcome window appears, click on Next.

8.
The Choose Destination dialog box is displayed.  
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To install to the selected folder click Next. To install to a different folder click Browse to search for the appropriate directory, and click Next.

9. 
The Restore Backup Data Selector window appears. Click No unless referencing backup data is required then click Yes.

10.
The Select Data Groups dialog box is displayed.
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An X indicates that the contents of the CD will be copied to the hard disk. The file size that will be copied is displayed after the CD’s volume name.
Selecting Individually: Click in the parenthesis preceding the CD volume name. If the box contains an X, the X will disappear. If the box is empty, an X will be inserted.

“Select All”: An alternative way to select the CD for copying.

“Clear All”: An alternative way to deselect the CD for copying. 
11.
In the Select Data Groups dialog box, select the CD’s you want to copy to the hard disk. Click “Next.”

The Select Disk Allocation window appears:
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“Mapping Policy”: Shows how the drive(s) on your system are listed in the dialog box: “Sorted by Space Available (Largest First)”, “By Drive Letter (A to Z)”, or “By Drive Letter (Z to A)”. This box may change the order in which the hard disk drives are listed in the dialog box.         

Disk Drive Information: For each hard disk drive in your system (listed by volume letter), these columns show total space, file space, a field for you to type how much space you want to reserve as free, and the resulting space available.

“Reserved”: This field lets you type the amount of information you want to keep free on the particular disk.
Caution:
Do not fill all your available hard disk space. Some free disk space is necessary for the operating system and for installing the product. Later you may want to install additional programs, which would require uninstalling and reinstalling the Isuzu Worldwide application.

“Available”: Shows how much total hard disk space is available to fulfill your CD copying selections.

“Space Required”: Shows how much hard disk space is needed to fulfill your CD copying selections.

“Back”: Returns you to the Isuzu Worldwide CD Set dialog box to change your CD copying selections.

“Next”: Click when you finish selecting drives to complete the automated installation.

“Cancel”: Click to cancel the installation process.

12.
If you selected CD’s to copy, enter any necessary information into the Select Disk Allocation window, then click on “Next”.

or 

If you selected no CD’s to copy, click “Next” to complete the automated installation process.

13.
When you click on Next at the Drive Mapping dialog box, Setup starts to copy files from the CD. The Progress Indicator windows indicate how the copying process is progressing.

14.
When the Installation Complete window appears, click on “Finish.”

Note: If you have not subscribed to pricing, skip Step 15 and go now to Step 16.  

15.
Open Windows Explorer and copy the file price.txt from its source media to the following directory:

C:\Program Files\Bhps\Izww183\UserFiles\price.txt

Note: The source media for your Price file depends on the media provided by your distributor. 

16.
Open the Isuzu Worldwide application by either of the following methods.

· Click on the Isuzu Worldwide icon from the Windows Desktop.
· Use the Start, Programs, and Isuzu Worldwide menus, then highlight and click the Isuzu Worldwide menu selection.

Turning On the System

Turn on the system components in the following order: (1) CD tower, if included; (2) monitor;
(3) system unit. XE "Turning On the System:Windows 95" 

 XE "Powering On the System:Windows 95" 

 XE "Windows 95:Turning On the System" 

 XE "Windows 95:Powering On the System" 
Opening the Application

When you turn on the system, the Windows Desktop appears. XE "Opening the __ Application:Windows 95" 

 XE "Windows 95:Opening the __ Application" 

 XE "Applications:Opening an Application from Windows 95" 

 XE "Desktop"  Double-click on the “Isuzu Worldwide” icon to open the application.

Alternative Procedure for Opening the Application

1.
From the Windows Desktop, click on the Start button to open the Start menu. XE "Backing Up Information:Windows 95" 

 XE "Windows 95:Backing Up Information" 
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2.
Click on “Programs” to open the Programs menu. Then click on “Isuzu Worldwide” to open a submenu.

[image: image45.bmp]
3.
Click on “Isuzu Worldwide” to open the application.

xe "Tool Bar\:Using the Tool Bar"
Printing

Normal Printing

To print the current page or a range of pages, select Print from the File menu to display the Print dialog box. Then click on “OK”. If more than one printer is available and you want to use a printer other than the one shown in the “Name” field, click on the arrow to open a list of printers. Then click on the printer you want so it appears in the “Name” field. XE "Printing:Windows 95" 

 XE "Windows 95:Printing" 

 XE "Print (command)" 

 XE "Windows 95:Print (command)" 
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Print Window

Opens the Print dialog box. Click on “OK” to print an image of the application window. If the application window is not maximized (does not fill the entire screen) and the Windows Desktop or some other window shows up in the background, only the application window is printed. XE "Print Window (command):Windows 95" 

 XE "Windows 95:Print Window (command)" 
Print Screen

Opens the Print dialog box. Click on “OK” to print an image of the entire screen display. XE "Print Screen (command):Windows 95" 

 XE "Windows 95:Print Screen (command)" 
Print Setup

If you want a different printer to show in the “Name” field each time you open the Print dialog box, select Print Setup from the File menu to display the Print Setup dialog box. Make any necessary setup changes and click on “OK”. XE "Setting Up a Print Job:Windows 95" 

 XE "Windows 95:Setting Up a Print Job" 

 XE "Print Setup (command)" 

 XE "Windows 95:Print Setup (command)"  The “Name” field shows the currently selected printer. Click on the arrow to the right of the current selection to open a list of available printers. Then click on the name of the printer you want. When you finish with setup, click on “OK”. When a Print dialog box covers information you need to see, place the mouse pointer on the box’s title bar, hold down the left mouse button, and drag an outline of the box to a new position. When you let go of the mouse button, the box moves to that position. To close a Print dialog box without starting a print job, click on Cancel or click on the close button (“X”) at the right end of the box’s title bar.

Print Status

When you start a print job, a printer icon appears on the taskbar. Right-click on the icon to see the printing status. When your print job is finished, the printer icon disappears. You can also double-click on the icon to see information about all current print jobs.

Closing the Application

After saving any Review List in progress, open the application File menu and select Exit to display an Exit confirmation box. Then click on “OK” to display the Windows Desktop. An alternative way to exit is to click on the “X” at the right end of the title bar. XE "Applications:Closing an Application in Windows 95" 

 XE "Windows 95:Closing the __ Application" 

 XE "Closing the __ Application:Windows 95" 
Exiting from Windows 95/98

Always exit from Windows before turning off the system.
1.
From the Windows Desktop, click on the Start button to open the Start menu. XE "Windows 95:Exiting" 

 XE "Exiting:Windows 95" 
2.
Click on “Shut Down” to display the Shut Down Windows dialog box.

[image: image47.png]B

A you sute you wark 0

@ i dowr the compiterd

O Bestart the computer?

O Restat the computer in M5 D05 mode?

© Cse al programs and log on as a diferent user?




3.
Since “Shut Down the Computer” is already highlighted, just click on “Yes”. A message appears when it is safe to turn off the system.

Turning Off the System

Generally, leave the system running during the work week. It is not necessary to turn power off at the end of each day. Always exit from all applications and from Windows before turning off your system. Turn system components off in the following order: (1) System unit;
(2) monitor; (3) CD tower, if included. XE "Windows 95:Turning Off the System" 

 XE "Windows 95:Powering Off the System" 

 XE "Turning Off the System:Windows 95" 

 XE "Powering Off the System:Windows 95" 

 XE "Shutting Down the System:Windows 95" 

 XE "Windows 95:Shutting Down the System" 
Responding to a Power Outage

If a power outage occurs, turn off the power switches on all system components. Doing this protects the components from damage when power is restored. When power is restored, turn the components back on in the order shown under “Turning On the System”. 

B  Windows NT

Performing Monthly Updates

Log Off All Windows 95/98 Clients

1.
At each client, close any programs that are running and exit to the Windows Desktop. XE "Updating the System:Windows NT" 

 XE "Monthly Updates:Windows NT" 

 XE "Windows NT:Updating the System" 

 XE "Windows NT:Monthly Updates" 
2.
Click on the Start button to open the Start menu.

3.
Click on “Shut Down” to display the Shut Down Windows dialog box.
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4.
Click on “Close All Programs and Log on as a Different User” to display the following prompt: “Press Ctrl + Alt + Delete to log on”. Leave this prompt displayed on each client’s screen while the update is in progress.

Update the Windows NT Server

1.
At the server, close any programs that are running and exit to the Windows NT Desktop.

2.
Click on the Start button to open the Start menu; click on “Programs” to open the Programs menu; and click on “Isuzu Worldwide” to open a submenu. Then click on “Backup”. 
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3.
A prompt appears: “Please insert the next disk to be used for this backup into A:”.

4.
Insert a diskette into the drive and click on “OK”. Use the diskettes provided with the system for backups. If the diskettes are labeled, use the one that reads “Backup-A/Before Update”.

5.
When “The backup operation has completed” appears, click on “OK” and remove the diskette from the drive.

6.
From the Windows NT Desktop, click on the Start button to open the Start menu. Then click on “Shut Down” to display the Shut Down Windows dialog box.
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7.
Click on “Close All Programs and Log On as a Different User”. Then click on “Yes” to display “Press Ctrl + Alt + Delete to log on”.
8.
Hold down the CTRL and ALT keys at the same time and press the DELETE key to open the Logon Information dialog box.



Enter a user name and password that is valid for this system.



User name:



Password:


Domain:



9.
Log in with a user name that has administrative privileges. Then click on “OK”. The Windows NT Desktop will appear.

10.
Insert the Isuzu Worldwide CD #1 into a CD drive.

11.
Click on the Start button to open the Start menu.

 XE "Backing Up Information:Windows 95" 

 XE "Windows 95:Backing Up Information" 12.
Click on Run to open the Run dialog box.

13.
In the Run dialog box, do one of the following:

13.1
In the “Open” field, type D:\ Setup.exe. Then click on OK.
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Note: Substitute your CD drive letter for “D:” in this example.

13.2
Click on the Browse button and browse to the drive containing the Isuzu Worldwide CD. Click on Setup.exe. With this file path displayed in the “Open” field, click on OK.

14.
When the Choose Setup Language dialog box appears, select your preferred language, English or German, and click on Next.

[image: image52.png]lect Language 8 =] B

Installation Language Selection

Flease select alanguage below o be used thioughout e
instaltion procedue.

s orowRL =





15. 
When the Welcome window appears, click on Next.

16.
The Choose Destination dialog box is displayed.  
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To install to the selected folder click Next. To install to a different folder click Browse to search for the appropriate directory, and click Next.

17. 
The Restore Backup Data Selector window appears. Click No unless referencing backup data is required, then click Yes.

18.
The Select Data Groups dialog box is displayed.
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An X indicates that the contents of the CD will be copied to the hard disk. The file size that will be copied is displayed after the CD’s volume name.
Selecting Individually: Click in the parenthesis preceding the CD volume name. If the box contains an X, the X will disappear. If the box is empty, an X will be inserted.

“Select All”: An alternative way to select the CD for copying.

“Clear All”: An alternative way to deselect the CD for copying. 
19.
In the Select Data Groups dialog box, select the CD’s you want to copy to the hard disk. Click “Next.”

The Disk Allocation window appears:
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 “Mapping Policy”: Shows how the drive(s) on your system are listed in the dialog box: “Sorted by Space Available (Largest First)”, “By Drive Letter (A to Z)”, or “By Drive Letter (Z to A)”. This box may change the order in which the hard disk drives are listed in the dialog box.

Disk Drive Information: For each hard disk drive in your system (listed by volume letter), these columns show total space, file space, a field for you to type how much space you want to reserve as free, and the resulting space available.

“Reserved”: This field lets you type the amount of information you want to keep free on the particular disk.
Caution:
Do not fill all your available hard disk space. Some free disk space is necessary for the operating system and for installing the product. Later you may want to install additional programs, which would require uninstalling and reinstalling the Isuzu Worldwide application.

“Available”: Shows how much total hard disk space is available to fulfill your CD copying selections.

“Space Required”: Shows how much hard disk space is needed to fulfill your CD copying selections.

“Back”: Returns you to the Isuzu Worldwide CD Set dialog box to change your CD copying selections.

“Next”: Click when you finish selecting drives to complete the automated installation.

“Cancel”: Click to cancel the installation process.
20.
If you selected CD’s to copy, enter any necessary information into the Select Disk Allocation window, then click on “Next”.

or 

If you selected no CD’s to copy, click on “Next” to complete the automated installation process.

21.
When you click on Next at the Drive Mapping dialog box, Setup starts to copy files from the CD. The Progress Indicator windows indicate how the copying process is progressing.

22.
When the Installation Complete window appears, click on “Finish.” 

Note: If you have not subscribed to pricing, skip Step 23 and go now to Step 24.

23.
Open Windows Explorer and copy the file price.txt from its source media to the following directory:

C:\Program Files\Bhps\Izww183\UserFiles\price.txt

Note: The source media for your Price file depends on the media provided by your distributor.
24.
Open the Isuzu Worldwide application by either of the following methods.

· Click on the Isuzu Worldwide icon from the Windows Desktop.
· Use the Start, Programs, and Isuzu Worldwide menus.

Windows NT Error Message

Use this procedure only if the error message “The wrong volume is in the drive. Please insert volume CDIZWW1 into the drive” appears while you are installing/updating your Windows NT server.

1.
Check to see which Service Pack is installed on your Windows NT server: Reboot the system. When the blue screen appears, the line across the top should appear similar to the following: “Microsoft (R) Windows NT (TM) Version 4.0 (Build 1381: Service Pack 3).”

2.
If your system is loaded with Service Pack 3 or older, download the latest Windows NT Service Pack from the Microsoft download site and install it on your system.

3.
Follow the procedure under “Performing Monthly Updates”. The error message should no longer appear.

Turning On the System

Turn on the system components in the following order: (1) CD tower, if included; (2) monitor; (3) system unit. XE "Turning On the System:Windows NT" 

 XE "Windows NT:Turning On the System" 

 XE "Powering On the System:Windows NT" 

 XE "Windows NT:Powering On the System" 
Opening the Application

When you turn on the system, the Windows Desktop appears. XE "Opening the MBNA Application:Windows NT" 

 XE "Windows NT:Opening the MBNA Application" 

 XE "Applications:Opening an Application from the Windows NT Desktop"  Double-click on the “Isuzu Worldwide” icon to open the application.

Alternative Procedure for Opening the Application

From the Windows Desktop, (1) click on the Start button to open the Start menu. XE "Opening the MBNA Application:Windows NT" 

 XE "Windows NT:Opening the MBNA Application" 

 XE "Applications:Opening an Application from the Windows NT Start Button"  (2) Click on “Programs” to open the Programs menu. (3) Click on “Isuzu Worldwide” to open a submenu. (4) Click on “Isuzu Worldwide” to open the application.
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Printing

Normal Printing

To print the current page or a range of pages, select Print from the File menu to display the Print dialog box. Then click on “OK”. If more than one printer is available and you want to use a printer other than the one shown in the “Name” field, click on the arrow to open a list of printers. Then click on the printer you want so it appears in the “Name” field. XE "Printing:Windows NT" 

 XE "Windows NT:Print (command)" 

 XE "Print (command)" 
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Print Window

Opens the Print dialog box. Click on “OK” to print an image of the application window. If the application window is not maximized (does not fill the entire screen) and the Windows desktop or some other window shows up in the background, only the application window is printed. XE "Windows NT:Print Window (command)" 

 XE "Print Window (command)" 
Print Screen

Opens the Print dialog box. Click on “OK” to print an image of the entire screen display. XE "Print Screen (command)" 

 XE "Windows NT:Print Screen (command)" 
Print Setup

If you want a different printer to show in the “Name” field each time you open the Print dialog box, select Print Setup from the File menu to display the Print Setup dialog box. Make any necessary setup changes and click on “OK”. XE "Setting Up a Print Job:Windows NT" 

 XE "Windows NT:Setting Up a Print Job" 

 XE "Print Setup (command)" 

 XE "Windows NT:Print Setup (command)"  The “Name” field shows the currently selected printer. Click on the arrow to the right of the current selection to open a list of available printers. Then click on the name of the printer you want. When you finish with setup, click on “OK”. When a Print dialog box covers information you need to see, place the mouse pointer on the box’s title bar, hold down the left mouse button, and drag an outline of the box to a new position. When you let go of the mouse button, the box moves to that position. To close a Print dialog box without starting a print job, click on Cancel or click on the close button (“X”) at the right end of the box’s title bar.

Print Status

When you start a print job, a printer icon appears on the taskbar. Right-click on the icon to see the printing status. When your print job is finished, the printer icon disappears. You can also double-click on the icon to see information about all current print jobs.

Closing the Application

After saving any Review List in progress, open the application File menu and select Exit to display an Exit confirmation box. Then click on “OK” to display the Windows Desktop. An alternative way to exit is to click on the “X” at the right end of the title bar.

Exiting from Windows NT

Always exit from Windows before turning off the system.
From the Windows desktop, click on the taskbar’s Start button to open the Start menu.  XE "Exiting:Windows NT" 

 XE "Windows NT:Exiting" 
Click on “Shut Down” to display the Shut Down Windows dialog box.
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Since “Shut Down the Computer” is already highlighted, just click on Yes. A message appears when it is safe to turn off the system. XE "Windows NT:Shutting Down" 

 XE "Shutting Down Windows NT" 
Turning Off the System

Generally, leave the system running during the work week. It is not necessary to turn power off at the end of each day. Always exit from all applications and from Windows before turning off your system. Turn system components off in the following order: (1) System unit;
(2) monitor; (3) CD tower, if included. XE "Turning Off the System:Windows NT" 

 XE "Powering Off the System:Windows NT" 

 XE "Windows NT:Turning Off the System" 

 XE "Windows NT:Powering Off the System" 

 XE "Shutting Down the System:Windows NT" 
Responding to a Power Outage

If a power outage occurs, turn off the power switches on all system components. Doing this protects the components from damage when power is restored. When power is restored, turn the components back on in the order shown under “Turning On the System”.

C  Troubleshooting

If you have problems running the Isuzu Worldwide application, use the information in this appendix to help isolate the problem. Some problems you may be able to remedy yourself. Others may require the assistance of Technical Support. Information is organized according to  the server, the clients, and a standalone system. Note: Throughout this appendix, “x” indicates a variable number.
Troubleshooting the Server

Check the Folders

1.
Open Windows NT Explorer.

2.
Click on the “C:\” hard drive icon.

3.
Click on “Program files”.

4.
Verify that the following folders exist:

Bell & Howell
C:\PROGRAM FILES\BHPS

Isuzu Worldwide EPC
C:\PROGRAM FILES\BHPS\IZWW183

System Software
C:\PROGRAM FILES\BHPS\SYS18x

Check the Services

1.
Click on the “Start” button and select “Settings”, then “Control Panel”.

2.
Click on “Services”.

3.
Verify the following: 

Service
Status

Bell & Howell PSC NT Service
STARTED

Bell & Howell Product License Manager
STARTED

Check the Logs

Check the Event Log

1.
Locate the “Event Log” at C:\Program Files\Common Files\Bhps.

2.
Open the log file named bhupdate.log  

3.
If you see messages beginning with phrases similar to “ Unable to . . .,” “Could not establish . . .,” etc., call Technical Support. 

Check the Update Log

1.
Click on the “Start” button and select “Programs”, then “Isuzu Worldwide”.

2.
Click on “Update Log” and scroll down to the date of the most recent update.

3.
If you see messages beginning with phrases similar to “Failed to write...”, call Technical Support.

Check the Media

Verify that the Isuzu Worldwide CDs are in the drives. Note: If you used the hard disk copy option to copy the database files to your hard disk, the CDs do not need to be in the drives.
Troubleshooting the Clients

Check the Application

Verify that the application runs on the server.

Check Shares at the Server

1.
Open an MS-DOS command prompt (Start Menu->Programs->Command Prompt).

2. Type the command "net share".

3. Output similar to the following should appear:

Share name   Resource                        Remark

---------------------------------------------------------------------C_Izww_FDA   C:\bhdata                       ePAR-C Drive (FDA)

D_Izww       D:\                             ePAR-D Drive

Izww-Bkrst   C:\Program Files\BHPS\Bkrst1    ePAR-Izww-Bkrst

Izww-CF      C:\Program Files\Common Files   ePAR-Izww-CF

Izww-flexlm  C:\Program Files\BHPS\lic       ePAR-Izww-flexlm

Izww-Instlr  C:\Program Files\BHPS\Instlr1   ePAR-Izww-Instlr

Izww-IZWW    C:\Program Files\BHPS\IZWW183   ePAR-Izww-IZWW

Izww-Sys     C:\Program Files\BHPS\Sys183    ePAR-Izww-Sys

The command completed successfully.

(Only the Isuzu WW shares are listed here. Your system might show additional share names.) 

4. Verify that all the Isuzu WW share names (as shown above) are listed in your output. 

Note that:

· "C:\PROGRAM FILES\BHPS" is the default installation path. The actual path can be changed at installation time, and will be reflected in the resource column shown above.

· Each hard drive where data is stored has a "\bhdata" folder, which is shared as "C_Izww_FDA " (where "C" is the letter of the hard drive where the data is stored). If data was allocated to more than one hard drive, each hard drive will have an entry.
· Each CD drive and DVD drive "D:\" is shared as "D_Izww". ("D" is replaced with the letter of the drive.)

Check Shares at Each Client

1.
From the Windows Desktop, click on the “Network Neighborhood” icon.

2.
Scroll through the “Contents of ‘Network Neighborhood’” until you see “Server”.

3.
Click on “Server” to open a list of files.

4. 
Verify that the server shares shown above are present.

Troubleshooting a Standalone System

Check the Folders

1.
Open Windows Explorer.

2.
Click on the “C:\” hard drive icon.

3.
Click on “Program files”.

4.
Verify that the following folders exist:

Bell & Howell
C:\PROGRAM FILES\BHPS

Isuzu Worldwide EPC
C:\PROGRAM FILES\BHPS\IZWW183

System Software
C:\PROGRAM FILES\BHPS\SYS18x

Check the Logs

Check the Event Log

1.
Locate the “Event Log” at C:\Program Files\Common Files\Bhps.

2.
Open the log file named bhupdate.log. 

3.
If you see messages beginning with phrases similar to “ Unable to . . .,” “Could not establish . . .,” etc., call Technical Support.

Check the Update Log

1.
Click on the “Start” button and select “Programs”, then “Isuzu Worldwide”.

2.
Click on “Update Log” and scroll down to the date of the most recent update.

3.
If you see messages beginning with phrases similar to “Failed to write...”, call Technical Support.

Check the Media

Verify that the Isuzu Worldwide CDs are in the drives. Note: If you used the hard disk copy option to copy the database files to your hard disk, the CDs do not need to be in the drives.

Troubleshooting Pricing

Zeros (0.00) appearing in place of standard prices in a Review List pricing column signals a problem with the price.txt file. The file may not exist in the proper location or the data in the file may not be properly formatted.

NOTE: Zeros appearing in Review List pricing columns for users who have not subscribed to pricing is a normal condition. To hide the columns from view, toggle pricing to OFF.

Check the File Location

The pricing data resides in a file named price.txt. Verify that this file exists at:

C:\Program Files\BHPS\IZWW183\UserFiles\price.txt
Contact Your EPC Distributor 

If price.txt is located in the proper directory and zeros still appear in a pricing column:

1. Contact your distributor to obtain an updated, properly formatted price.txt file.

2. Copy the updated price.txt file into:

C:\Program Files\BHPS\IZWW183\UserFiles\price.txt
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The last digit of this number tells you which CD to insert.
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